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1. INTRODUCTION  

 
The National Weather Radar Testbed 
(NWRT) in Norman Oklahoma is a new 
national asset for weather radar research 
(Forsyth et al 2005). It is located at the 
National Severe Storms Laboratory (NSSL) 
on the University of Oklahoma’s North 
campus.  During the spring of 2006 NSSL 
staff (both federal and contractor) will be 
relocating to the National Weather Center 
(NWC), located on the South campus of the 
University of Oklahoma.  The NWRT facility 
will remain at the North campus site and will 
require the ability to operate the radar 
remotely from the NWC. In addition, current 
plans are to allow researchers from across 
the nation to remotely access the NWRT to 
support their research.  To support this new 
remote access requirement, the Radar 
Control Interface (RCI) has been developed.  
This paper describes the features of the 
RCI. 
 
2. SYSTEM OVERVIEW 
 
The physical characteristics of the NWRT 
are described in the paper by Forsyth et al 
(2005).  The RCI interacts with two major 
components: the Real-Time Controller 
(RTC) and the Environmental Processor 
(EP).  To allow simultaneous recording of 
moment and time-series data, the EP has 
been divided into two subcomponents; one 
for moment processing and the other for 
time series recording. 
 
In its legacy configuration, the NWRT is 
controlled by software running from a 
dedicated position.  This software, referred 
to as the Radar Scheduler (RS) can be run 
inside the radar structure or at a dedicated 
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workstation located in the NWRT Operations 
Center.  Only one instance of the RS can be 
running at a given moment.  Unless the 
radar is being used for maintenance 
purposes the RS is always run at the NWRT 
Operations Center. 
 
Communication between system 
components is done through socket 
connections with the RS.  Both the EP and 
RTC components send status messages to 
the RS and receive data and commands 
from the RS.  The RS must be running 
before all other components are started.  If 
the RS is restarted, then all other 
components must be restarted as well.  
Modifications are planned to the RTC and 
EP software to eliminate these 
dependencies. 
 
In our current configuration, the RCI 
replaces the legacy RS function.  It is based 
on a client-server model with the RCI server 
communicating directly with the RTC and EP 
components.  RCI clients interact with the 
RTC and EP components through the RCI 
server.  One or more RCI clients can 
simultaneously communicate with the RCI 
server either retrieving status or sending 
commands to the other components.  
However, only one RCI client can be in 
control of the system at any given moment. 
 
3. RCI SERVER 
 
The RCI server component is a stand-alone 
multi-threaded Java-based application that 
directs all activity in the system.  Once it is 
started, it handles all communication 
between users (clients) and system 
components.  As each component is started 
a connection is established with the server 
and a new thread is started to handle 
communication between the server and the 
component.  The RCI server currently runs 
on a Sun Ultra10 workstation but future 
plans are to eventually replace this with a 



Linux-based PC.  Since the software is 
totally Java-based, no modifications will be 
required during the transition. 
 
One important issue concerning remote 
access to the NWRT is security.  In addition 
to the security provided by the NSSL 
firewall, access to the RCI server from RCI 
clients is controlled using a write protected 
host/user file residing at the RCI server.  
RCI clients communicate with the RCI 
server using a standard socket connection.  
When an RCI client establishes a 
connection to the RCI server, the RCI server 
extracts the user and host names from a 
predefined login message passed to the RCI 
server from the RCI client.  If the user and 
host names are not found in the host/user 
file, the RCI server closes the connection 
with the RCI client.  The contents of the 
host/user file are write-protected and 
maintained by the NWRT system 
administrator. 
 
An important function of the RCI server is to 
handle requests from RCI clients.  A request 
can be either a system control command or 
a request for information.  Information can 
include status, logs, file lists, common data, 

etc.  A set of predefined messages have 
been developed to handle requests to and 
information from the RCI server. The RCI 
server can accommodate up to 128 
separate RCI clients running simultaneously 
allowing multiple users to monitor the 
system at any given time.  
 
Another function of the RCI server is to keep 
a record of all system activity.  This activity 
includes system commands directed from 
RCI clients, status information, and errors.  
These system logs are available for viewing 
by RCI clients on demand.  The client can 
specify a set of filtering criteria for a request. 
 
4. RCI CLIENT 
 
The RCI client is a Java-based GUI 
application which serves as the interface 
between the user and the system.  It 
communicates only with the RCI server and 
can be run from any point on the network as 
long as a socket connection can be made to 
the host running the RCI server.  It is 
functionally divided into two distinct 
components: control and status.  A sample 
RCI client display window is presented in 
Figure 1.   

 

 
Figure 1:  Sample RCI Client Display (System tabbed window view)



 
4.1 RCI Client Control 
 
The control component of the RCI client 
consists of a set of dropdown menus located 
near the top of the RCI client display 
window.  The dropdown menus are grouped 
as follows: File, System, Scan, Data, and 
Help.   
 
The File menu item contains selections to 
download data contained in files from the 
server to other NWRT components.  For 
instance, to be able start a data collection 
scan, one must first download a file, called a 
Super Stimulus, to the RTC and EP 
components.  A Super Stimulus file contains 
information needed to perform one or more 
volume scans (i.e., PRF, beam direction, 
pulses).  Other file types that can be 
accessed include calibration, radiation inhibit 
sectors, and data playback files.  An Exit 
selection is provided to terminate the client. 
 
The System menu item contains selections 
to request/release system control and 
startup/shutdown system components.  It 
also contains selections to control the 
transmitter. 
 
The Scan menu item contains selections to 
control scan processing (start, stop), control 
the pedestal (stop, position, stow), and stop 
the transmitter from radiating.  
 
The Data menu item contains selections to 
control time series (I/Q) and moment data 
recording. 
 
The Help menu item provides information on 
the operation of the system. 
 
To begin a typical data collection operation, 
one would first select a Super Stimulus file 
from the File menu, enable the pedestal 
(currently done using a physical keyed 
switch in the Operations Center), activate 
the transmitter from the System menu, and 
then start the scan by selecting the scan 
start selection from the Scan menu. 
 
Most of the menu selections are active only 
after the user requests and is granted 
control by the RCI server.  Otherwise, they 
are inactive (desensitized).  When an RCI 
client is controlling, no other RCI client can 

send control commands to the RCI server 
until control is released by the controlling 
RCI client.  A control override is provided in 
the event a non-controlling RCI client needs 
to take control from a controlling RCI client. 
However, in order to override another RCI 
client the user will need override authority 
(which is determined by the RCI server 
using information contained in the host/user 
file). The title of the RCI client window 
indicates whether it is controlling or non-
controlling (also if the client is controlling, all 
control selections will be sensitized) 
. 
4.2 RCI Client Status 
 
The status component of the RCI client is 
always active.  A group of tabbed windows 
are used to organize status information into 
related groups.  Each tabbed window 
contains a specific collection of status items.  
Currently, the main tab groups are: System, 
RCI Client/Server, Antenna/Pedestal, 
Transmitter, and History. 
 
The System tabbed window provides a 
composite view of the NWRT system.  This 
is the view that an operator will normally 
want to display.  It shows the state of each 
NWRT component and the most important 
status information from the RTC and EP 
components.  It also shows the active Super 
Stimulus and the user who is in control (if 
there is a controlling client).  A graphical 
representation of the radar facility is 
displayed in the upper left portion of the 
window indicating the pedestal position, 
whether the pedestal interlock is enabled, 
the state of the transmitter/high voltage, and 
whether there are antenna, transmitter or 
pedestal alarms active.  It also displays the 
two most recent log messages and the two 
most recent RTC or EP error messages.  If 
the EP or RTC components are down, all 
associated status items are tagged as “not 
available”. 
 
The RCI Client/Server tabbed window 
provides information about RCI clients and 
the RCI server.  An icon pushbutton object is 
displayed for each active RCI client.  Non-
controlling RCI clients are displayed in blue 
and the controlling RCI client is displayed in 
red.  The icon used for the local RCI client is 
different from the icon used for all other RCI 



clients.  The user and host names of each 
client can be obtained by moving the cursor 
over its associated pushbutton object.  If a 
user wants to send a text message to 
another user they can select the icon 
pushbutton associated with that user, fill out 
a simple form, and then select a button to 
send the message. 
 
The Antenna/Pedestal tabbed window 
contains status information pertaining to the 
pedestal and antenna.  This information is 
received regularly by the RCI server from 
the RTC component and sent to RCI clients 
on request.  If the RTC component is down 
then all status items are tagged as “not 
available”.  Selections are provided to 
command specific antenna tests (controlling 
RCI client only) and display the results of 
completed tests (all RCI clients).  A sample 
antenna test report display is presented in 
Figure 2. 
 
The Transmitter tabbed window contains 
general transmitter status and individual 
transmitter fault status information.  As with 
the Antenna/Pedestal window, it contains 
information sent to the RCI server from the 

RTC component.  If the RTC component is 
down then all status items are tagged as 
“not available”. 
 
The History tabbed window displays system 
log information.  The logs are presented in 
reverse chronological order (latest message 
at the top of the display list) and tagged by 
type (status, command and error) and 
component (RCI, RTC and EP).  Filter 
switches are provided for the user to select 
a combination of type and component.  In 
addition, the user can enter a text string so 
that only messages containing the string are 
displayed.  A sample RCI History window 
display is presented in Figure 3. 
 
As long as the client is running, status 
requests are automatically sent by RCI 
clients to the RCI server in 2 second 
intervals.  The RCI server sends a status 
message back and the RCI status display 
objects are refreshed.  If the RCI client 
doesn’t receive status back in a preset 
amount of time, the connection with the RCI 
server is terminated and an attempt is made 
to reconnect with the RCI server. 

. 
 
 

 
Figure 2:  Sample RCI Client Antenna Power Supply Data Bus Check Test Report Display. 
 
 
 
 
 



 
Figure 3:  Sample RCI Client History Window Display 
 
 
5. SUMMARY 
 
A new software package, called the Radar 
Control Interface (RCI), has been developed 
for the National Weather Radar Testbed 
(NWRT).  With the impending move of NSSL 
staff to the new National Weather Center 
(NWC) and the physical location of the radar 
at the current NSSL site, remote control 
capability is required to support the move. 
The RCI has been designed to allow 
multiple users to monitor, and a single user 
to control, the radar from remote locations.  
Security features have been implemented to 
restrict user and host access and allowing a 
single user to control the system at a given 
point in time.  Not only does this design 
allow remote control from the NWC, it also 
allows researchers from outside the Norman 
community to operate the radar.  Future 
enhancements include a moment display 
window, calendar type scheduler, and an 
expanded logging capability to capture user 
generated information during data collection. 

 
6. ACKNOWLEDGEMENTS 
 
This paper was prepared by David Priegnitz 
and Douglas Forsyth with funding provided 
by NOAA/Office of Oceanic and 
Atmospheric Research under NOAA-
University of Oklahoma Cooperative 
Agreement #NA17RJ1227, U.S. Department 
of Commerce.  The statements, findings, 
conclusions, and recommendations are 
those of the authors and do not necessarily 
reflect the views of NOAA or the U.S. 
Department of Commerce. 
 
7. REFERENCES 
 
Forsyth, D.E., J.F. Kimpel, D.S. Zrnic, R. 
Ferek, J. F. Heimer, T. McNellis, J. E. Crain, 
A. M. Shapiro, R. J. Vogt and W. Benner, 
2005: The National Weather Radar Testbed 
(Phased-Array). Preprints, 32nd Conference 
Radar Meteorology, Albuquerque, NM, 
Amer. Meteor. Soc., CD-ROM, 12R.3 

 
 

 
 



 


